FILE OPERATIONS
2R Data is capable of reading and writing .2rd files, which contain the complete description of a specific data
model:
1.
2.

Series names.
Series data values.

These files are the means for 2R Data users to save their work, as well as the medium of distribution of data
models that could be of interest to other 2R Data users.

SAVING DATA MODELS
At any given time, a user can decide to save a data model’s information for later use. In order to do this, the user
must navigate through the File menu and select the Save or Save As… option:

The difference between Save and Save As… is that, while Save will only ask for the file’s name and destination
once and will then overwrite that same file on any subsequent uses, Save As… will ask for the file’s name and
destination every time it is invoked. Thus, Save As… is to be used whenever a user wants to save modifications
made to a file without modifying the base file.

OPENING DATA MODELS
In order to load the information contained inside a .2rd file, the user must navigate through the File menu and
select the Open option:

If no errors occur, the loaded model is shown in the Main tab (series names and data values).

STARTING NEW DATA MODELS
If a user is done working with a data model and wants to start a new one, the New option from the File menu
provides this functionality:

Before the new model is created, the user is given the chance to save his current work.

SERIES MANAGEMENT
ADDING A SERIES
In order to add a series to a data model, a user must navigate through the Series menu and select the Add Series
option:

An input dialog will appear asking for the new series’ name. If the user enters a name that hasn’t yet been used in
the current data model, the new series shows up in the Main tab ready for editing.

REMOVING A SERIES
If a data model contains a data series that is no longer needed, the user can request its elimination by navigation
through the Series menu and selecting the Delete Series option:

The user is then prompted to enter the name of the series to be deleted. If the input matches one of the current
data model’s series, that series and its corresponding data values are eliminated from the Main tab.

INPUTTING AND MODIFYING DATA
2R Data offers a straight-forward editing interface in the Main tab. The following table summarizes the different
actions that a user can carry out in 2R Data’s spreadsheet editor:
Action
Add values to a series

Modify a specific value of a series

Delete a value from a series

How To
1. Select the series’ last cell (the one that is always blank).
2. Write a value to be added.
3. Hit the ENTER key.
4. Repeat steps 2 and 3 until all the values have been added.
There are two ways of going about this task:
 Double-click over the cell that contains the value to be edited, make
the desired changes, and then hit the ENTER key.
 To overwrite a value, select the appropriate cell (single click) and
write the new value. Then, hit the ENTER key.
1. Select the cell that contains the value to be deleted (single click).
2. Hit the DEL or DELETE key.

IMPORTING DATA FROM A FILE
Given that, in real life, most data analysis is done based on files generated by specialized equipment and other
types of external sources, 2R Data gives users the option to import data from a wide assortment of file formats. To
initiate the data import module, navigate through the Edit menu and select the Import Data from file option:

A dialog box appears asking for information regarding the external file’s format:

An important thing to have in mind before importing data is that 2R Data assumes that the series are organized
by columns in the external file. Thus, each column must represent a series of data and each row must contain at
most one data value of a given series.
The First row contains series name checkbox is to be checked if and only if you want the text from the first row to
be taken as the name of the different series contained in the external file.
Warning: if a series from the external file has the same name as one of the existing series in the current 2R Data
model, all of the data values of the existing series are deleted and the ones from the external file take their place.

When the First row contains series name checkbox is left unchecked, 2R Data will ask for the name to be assigned
to the data of each of the columns in the external file. Warning: if a series from the external file is given the same
name as one of the existing series in the current 2R Data model, all of the data values of the existing series are
deleted and the ones from the external file take their place.
Once the dialog options are correctly set, clicking the Start button will open a file selection dialog which the user
should use to select the file to be imported.

FILE TYPES
The following table summarizes and exemplifies the different types of external files that 2R Data supports for data
importing tasks. Note that 2R Data assumes “.” (dot) to be the decimal separator and DOES NOT support
numbers with 1000 separator *usually “,” (comma)+.

File Type
Excel 2003 File (.xls)

Description and Examples
Files created with Microsoft Excel and saved with the XLS extension. It is a
proprietary format.
Examples:
First row contains series names

Excel 2007 File (.xlsx)
Comma-Separated (CSV)

First row doesn’t contain series names

Same as the Excel 2003 file, but saved with the XLSX extension. It is an open
XML-based format.
Simple text-based format that uses the “,” (comma) character to separate values
in one column from the values in the next column.
Examples (same data as the examples in the Excel 2003 File description):
First row contains series names First row doesn’t contain series names

TAB-Delimited

Simple text-based format that uses the TAB character to separate values in one
column from the values in the next column.
Examples (same data as the examples in the Excel 2003 File description):
First row contains series names First row doesn’t contain series names

Other Delimiter

Simple text-based format that employs a user-defined character sequence to
separate values in one column from the values in the next column.
Examples using “&&” as the delimiter:
(same data as the examples in the Excel 2003 File description):
First row contains series names First row doesn’t contain series names

PASTING DATA FROM EXCEL
Given that Microsoft Excel is the de facto standard for spreadsheet management, 2R Data has been enhanced to
allow an intuitive flow of information with that program. Therefore, users can copy and paste data from Excel into
the 2R Data user interface with ease, both by using hotkeys and by using explicit menu options.

METHOD 1 - HOTKEYS
1. In Microsoft Excel, highlight the data values that you wish to paste into a 2R Data model:

2. Then, press the CTRL and the C keys simultaneously (ctrl+c).

3. Now, open 2R Data and start a new data model or open an existing one. In order to be able to paste the data
into the program, you must already have some series in your current file.
4. In 2R Data’s Main tab, select the cell that will act as the top-left cell of the imported data. Warning: the Excel
data will overwrite data values of the current model if the position of the imported values coincides with the
position of existing values.

5. Press the CTRL and the V keys simultaneously (ctrl+v).
6. The data is copied to 2R Data:

Note that, as the warning from step 4 suggests, some values from the x and y series got overwritten by the Excel
data.

METHOD 2 – EXPLICIT MENU OPTIONS
1. In Microsoft Excel, highlight the data values that you wish to paste into a 2R Data model:

2. Right click over the selection and select the Copy option.

3. Now, open 2R Data and start a new data model or open an existing one. In order to be able to paste the data
into the program, you must already have some series in your current file.
4. In 2R Data’s Main tab, select the cell that will act as the top-left cell of the imported data. Warning: the Excel
data will overwrite data values of the current model if the position of the imported values coincides with the
position of existing values.

5. Navigate through the Edit menu and click over the Paste Excel Data option.

6. The data is copied to 2R Data:

Note that, as the warning from step 4 suggests, some values from the x and y series got overwritten by the Excel
data.

EXPORTING DATA
Even though 2R Data provides a variety of ways to analyze one or more data series, some users might want to
carry out operations on a data model’s information with other software packages. For that reason, 2R Data users
are given the option to export a model’s series and their data values to XLSX (Excell 2007) format. The option to do
this is located under the Export menu and is labeled as Export data to Excel.

REPORT GENERATION
2R Data is capable of exporting all the useful information that results from a data analysis to PDF format. To do
this, a user must navigate through the Export menu and select the Generate Report option. This option will only
be enabled if a successful analysis has been completed.

The user is then prompted for the new report’s name and location before 2R Data creates the PDF file.

BASICS
GRAPHS
All of the graphs generated in 2R Soft provide a wide array of options in the form of a context menu. The context
menu appears when you right-click over a graph:

PROPERTIES PANE
If you select the Properties… option, a properties pane appears. The properties pane lets you change the graph
title, axis names, axis ranges, and font size.

COPY AND SAVE AS…
If you select COPY, the graph is copied to the system clipboard, so you can PASTE it anywhere else (Microsoft
Word, Microsoft PowerPoint, etc).
Meanwhile, if Save As… is selected, 2R Soft will save the graph as a PNG image file in your hard disk after selecting
the desired output folder and file name:

PRINT
The Print option does just that: it sends the graph to the printer of your choice (local or networked):

SCALE OPTIONS
The Auto Range, Zoom In, and Zoom Out options are a quick way to inspect the graph. If a very specific range is
needed for an axis, we highly recommend the Properties Pane.

MANUAL ZOOM IN
For user convenience, all 2R Soft graphs support manual zoom in by regions. If you’re interested in a specific
region, hold your left-click and drag the mouse to generate a highlighted box around that region:

The end result:

NORMALIZED AND CUMULATIVE HISTOGRAMS
Normalized and Cumulative histograms are found all throughout 2R Soft. These two types of graphs are of great
importance, considering that they show the stochastic tendencies of a data set. With them, a goodness-of-fit table
is displayed with various probability distributions and the best estimates for their parameters, along with different
goodness-of-fit tests:

The distribution selected in the goodness-of-fit table is juxtaposed with the histograms (red curve).

PROBABILITY DISTRIBUTION TYPES
When declaring a variable with a known distribution, the user can select one of many types of probability
distributions.
Distribution

Beta

Description
The beta distribution has shape parameters α > 0 and β > 0 over the
interval (a, b), where a < b.
It has density:
f (x) = (x - a)α-1(b - x)β-1/[B(α, β)(b - a)α+β-1]
for a < x < b, and 0 elsewhere.

Parameters
Alpha – shape parameter, alpha > 0
Beta – shape parameter, beta > 0
a – lower bound of the interval
b – upper bound of the interval, b > a

It has the following distribution function:
F(x) = Iα, β(x) = ∫ax(ξ - a)α-1(b - ξ)β-1/[B(α, β)(b - a)α+β-1]dξ, for a < x < b

Binomial

(Simard)
The binomial distribution with parameters n and p, where n is a
positive integer and 0 <= p <= 1. Its mass function is given by:
p(x) = nCr(n, x)px(1 - p)n-x = n!/[x!(n - x)!] px(1 - p)n-x for x = 0, 1, 2,…n,

p – probability of success on each trial
(0 p 1)
n – number of trials (integer), n > 0

and its distribution function is:
F(x) = ∑j=0xnCr(n, j) pj(1 - p)n-j
for x = 0, 1, 2,…n,
where nCr(n, x) is the number of possible combinations of x elements
chosen among a set of n elements.

Chi Square

(Simard)
The chi-square distribution with n degrees of freedom, where n is a
positive integer. Its density is:
f (x) = x(n/2)-1e-x/2/(2n/2Γ(n/2)),
for x > 0
where Γ(x) is the gamma function. The chi-square distribution is a
special case of the gamma distribution with shape parameter n/2 and
scale parameter1/2.
(Simard)

n – degrees of freedom (integer), n>0

Deterministic

Distribution that represents a constant value, val. Consequently:

Discrete Uniform

The discrete uniform distribution over the integers in the range [i, j]. Its
mass function is given by:
p(x) = 1/(j - i + 1)
for x = i, i + 1,…, j
and 0 elsewhere.

( )

{

( )

Value – any real number

{
Min. – lower bound (integer)
Max. – upper bound (integer)
(Max. > Min.)

The distribution function is:
F(x) = (floor(x) - i + 1)/(j - i + 1)
for i <= x <= j
and its inverse is:
F-1(u) = i + (j - i + 1)u
for 0 <= u <= 1.

Exponential

F-Distribution

Gamma

(Simard)
The exponential distribution with mean 1/λ where λ > 0. Its density is:
f (x) = λe-λx
for x >= 0,
its distribution function is:
F(x) = 1 - e-λx,
for x >= 0,
and its inverse distribution function is:
F-1(u) = - ln(1 - u)/λ,
for 0 < u < 1
(Simard)
The Fisher F distribution with n and m degrees of freedom,
where n and m are positive integers. Its density is:
f (x) = Γ((n + m)/2)nn/2mm/2/[Γ(n/2)Γ(m/2)]x(n-2)/2/(m + nx)(n+m)/2, for x > 0.
where Γ(x) is the gamma function
(Simard)
The gamma distribution with shape parameter α > 0 and scale
parameter λ > 0. The density is:
f (x) = λαxα-1e-λx/Γ(α),
for x > 0,
where Γ is the gamma function, defined by:
Γ(α) = ∫0∞xα-1e-xdx.

Lambda – rate parameter, lambda > 0

D.O.F. 1 – the n degrees of freedom
(integer), D.O.F. 1 > 0
D.O.F. 2 – the m degrees of freedom
(integer), D.O.F. 2 > 0

Alpha – shape parameter, alpha > 0
Lambda – scale parameter, lambda>0

In particular, Γ(n) = (n - 1)! when n is a positive integer.

Geometric

Gumbel

Hypergeometric

(Simard)
The geometric distribution with parameter p, where 0 < p < 1. Its mass
function is:
p(x) = p (1 - p)x,
for x = 0, 1, 2,…
The distribution function is given by:
F(x) = 1 - (1 - p)x+1,
for x = 0, 1, 2,…
and its inverse is:
F-1(u) = floor(ln(1 - u)/ln(1 - p)),
for 0 <= u < 1
(Simard)
The Gumbel distribution, with location parameter δ and scale
parameter β≠ 0. Using the notation z = (x - δ)/β, it has density:
f (x) = e-ze-e-z/| β|,
for - ∞ < x < ∞.
and distribution function:
F(x) = e-e-z,
for β > 0
F(x) = 1 - e-e-z,
for β < 0
(Simard)
The hypergeometric distribution with k elements chosen
among l, m being of one type, and l - m of the other. The
parameters m, k and l are positive integers
where 1 <= m <= l and 1 <= k <= l. Its mass function is given by:
p(x) = nCr(m, x)nCr(l - m, k - x)/nCr(l, k)
for max(0, k - l + m) <= x <= min(k, m)
where nCr(n, x) is the number of possible combinations of x elements
chosen among a set of n elements.
(Simard)

p – probability of success on each trial
(0 < p < 1)

Beta – scale parameter, beta 0
Delta – location parameter, any real
number

m – number of elements of one type
(integer), m > 0
l – total elements (integer), l > 0
k – number of elements chosen
among l (integer), k > 0

Logistic

The logistic distribution. It has location parameter α and scale
parameter λ > 0. The density is:
f (x) = (λe-λ(x-α))/((1 + e-λ(x-α))2)
for - ∞ < x < ∞.
and the distribution function is:
F(x) = 1/[1 + e-λ(x-α)]
for - ∞ < x < ∞.

Alpha – location parameter, any real
number
Lambda – scale parameter, lambda>0

For λ = 1 and α = 0, one can write:
F(x) = (1+tanh(x/2))/2.
The inverse distribution function is given by:
F-1(u) = ln(u/(1 - u))/λ + α
for 0 <= u < 1

Lognormal

(Simard)
The lognormal distribution. It has scale parameter μ and shape
parameter σ > 0. The density is:
f (x) = ((2π)1/2σx)-1e-(ln(x)-μ)2/(2σ2) for x > 0, and 0 elsewhere.

log mu – scale parameter, any real
number
log sigma – shape parameter,
log sigma > 0

The distribution function is:
F(x) = Φ((ln(x)-μ)/σ)
for x > 0,
where Φ is the standard normal distribution function.
Its inverse is given by:
F-1(u) = eμ+σΦ-1(u)
for 0 <= u < 1
If ln(Y) has a normal distribution, then Y has a lognormal distribution
with the same parameters.

Negative Binomial

(Simard)
The negative binomial distribution with real parameters γ and p,
where γ > 0 and 0 <= p <= 1. Its mass function is:
p(x) = Γ(γ + x)/(x! Γ(γ))pγ(1 - p)x,
for x = 0, 1, 2,…
where Γ is the gamma function.

Gamma – number of failures until the
experiment is stopped,
Gamma > 0
p – success probability in each
experiment, 0 p 1

If γ is an integer, p(x) can be interpreted as the probability of
having x failures before the γ-th success in a sequence of independent
Bernoulli trials with probability of success p.

Normal

(Simard)
The normal distribution. It has mean μ and variance σ2. Its density
function is:
f (x) = e-(x-μ)2/(2σ2)/((2π)1/2σ) for - ∞ < x < ∞ , where σ > 0.

Mean – self-explanatory, any real
number
Standard Deviation – self-explanatory,
Std. Dev. > 0

When μ = 0 and σ = 1, we have the standard normal distribution, with
corresponding distribution function:
F(x) = Φ(x) = ∫-∞xe-t2/2 dt/(2π)1/2
for - ∞ < x < ∞.

Pareto

(Simard)
The Pareto family, with shape parameter α > 0 and location
parameter β > 0. The density for this type of Pareto distribution is:
f (x) = αβα/xα+1 for x >= β, and 0 otherwise.

Alpha – shape parameter, alpha > 0
Beta – location parameter, beta > 0

The distribution function is:
F(x) = 1 - (β/x)α
for x >= β,
and the inverse distribution function is:
F-1(u) = β(1 - u)-1/α
for 0 <= u < 1

Poisson

Student's T

(Simard)
The Poisson distribution with mean λ >= 0. The mass function is:
p(x) = e-λλx/(x!),
for x = 0, 1,...
and the distribution function is:
F(x) = e-λ∑j=0x λj/(j!),
for x = 0, 1,....
(Simard)
The Student-t distribution with n degrees of freedom, where n is a
positive integer. Its density is:
f (x) = [Γ((n + 1)/2)/(Γ(n/2)(πn)1/2)][1 + x2/n]-(n+1)/2 for - ∞ < x < ∞,
where Γ(x) is the gamma function
(Simard)

Lambda – mean, lambda

0

D.O.F – degrees of freedom (integer),
D.O.F > 0

Triangular

The triangular distribution with domain [a, b] and mode (or shape
parameter) m, where a <= m <= b. The density function is:
f (x) = 2(x - a)/[(b - a)(m - a)]
for a <= x <= m,
f (x) = 2(b - x)/[(b - a)(b - m)]

for m <= x <= b,

f (x) = 0

elsewhere,

a – lower bound of the domain, any
real number
b – upper bound of the domain, any
real number
mode – shape parameter, any real
number
“a

the distribution function is:
F(x) = 0

mode

b” must be satisfied

for x < a,

F(x) = (x - a)2/[(b - a)(m - a)]

if a <= x <= m,

F(x) = 1 - (b - x)2/[(b - a)(b - m)]

if m <= x <= b,

F(x) = 1

for x > b,

and the inverse distribution function is given by:
F-1(u) = a + ((b - a)(m - a)u)1/2
if 0 <= u <= (m - a)/(b - a),
F-1(u) = b - ((b - a)(b - m)(1 - u))1/2

Uniform

if (m - a)/(b - a) <= u <= 1

(Simard)
The uniform distribution over the interval [a, b]. Its density is:
f (x) = 1/(b - a) for a <= x <= b, and 0 elsewhere.

Min. – lower bound
Max. – upper bound
(Max. > Min.)

The distribution function is:
F(x) = (x - a)/(b - a)
for a <= x <= b
and its inverse is:
F-1(u) = a + (b - a)u

Weibull

for 0 <= u <= 1

(Simard)
The Weibull distribution with shape parameter α > 0, location
parameter δ, and scale parameter λ > 0. The density function is:
f (x) = αλα(x - δ)α-1e-(λ(x-δ))α
for x > δ.
the distribution function is:
F(x) = 1 - e-(λ(x-δ))α
for x > δ,
and the inverse distribution function is:
F-1(u) = (- ln(1 - u))1/α/λ + δ
for 0 <= u < 1
(Simard)

Alpha – shape parameter, alpha > 0
Lambda – scale parameter, lambda>0
Delta – location parameter, any real
number

GOODNESS-OF-FIT (GOF) STATISTICS
To decide whether to accept or reject a proposed probability distribution for the generated data, it is necessary to
at least use one goodness-of-fit statistic as a criterion.
Col.
A-D

Test Type
AndersonDarling

Explanation
The Anderson-Darling test is defined as:
H0:
The data follow a specified distribution.
Ha:

The data do not follow the specified
distribution

Test
The Anderson-Darling test statistic is defined
Statistic: as

where

F is the cumulative distribution function of
the specified distribution. Note that the Yi are
the ordered data.
The test is a one-sided test and the
hypothesis that the distribution is of a specific
form is rejected if the test statistic, A, is
greater than the critical value.

K-S

KolmogorovSmirnov

(SEMATECH2)
The Kolmogorov-Smirnov test is defined by:
H0:
The data follow a specified distribution
Ha:

The data do not follow the specified
distribution

Test
The Kolmogorov-Smirnov test statistic is
Statistic: defined as
where F is the theoretical cumulative
distribution of the distribution being tested
which must be a continuous distribution (i.e.,
no discrete distributions such as the binomial
or Poisson), and it must be fully specified.

K-S+
and
K-S-

KolmogorovSmirnov+
and
KolmogorovSmirnov-

(SEMATECH1)
Given a sample of n independent uniforms Ui over [0, 1],
the Kolmogorov-Smirnov+ statistic Dn+ and
the Kolmogorov-Smirnov- statistic Dn-, are defined by
Dn+ = max1 <= j <= n(j/n - U(j)),
Dn- = max1 <= j <= n(U(j) - (j - 1)/n),

Critical Values
The critical values for the Anderson-Darling test are
dependent on the specific distribution that is being
tested. (SEMATECH2)
For Normal and Lognormal distributions:
alpha

0.1

0.05

0.025

0.01

A2crit

0.631

0.752

0.873

1.035

For Weibull and Gumbel distributions:
alpha

0.1

0.05

0.025

0.01

A2crit

0.637

0.757

0.877

1.038

(Annis)

An attractive feature of this test is that the distribution of
the K-S test statistic itself does not depend on the
underlying cumulative distribution function being tested.
Therefore, the critical values are universal. (SEMATECH1)
For samples with more than 35 values: (ERI)
Significance
Critical Value

0.20

0.15

0.10

0.05

0.01

√

√

√

√

√

The same from the K-S test.

where the U(j) are the Ui sorted in increasing order. Both
statistics follows the same distribution function,
i.e. Fn(x) = P[Dn+ <= x] = P[Dn- <= x]

CVM

Cramér-von
Mises

(Simard)
Given a sample of n independent uniforms Ui over [0, 1],
the Cramér-von Mises statistic Wn2 is defined by
Wn2 = 1/12n + ∑j=1n(U(j) - (j-0.5)/n)2,
where the U(j) are the Ui sorted in increasing order. The
distribution function (the cumulative probabilities) is
defined as Fn(x) = P[Wn2 <= x]
(Simard)

As with the K-S test, the critical values are universal:
Significance
N
0.20
0.15
0.10
0.05
0.01
2
0.138 0.149 0.162 0.175 0.186
10
0.125 0.142 0.167 0.212 0.32
20
0.128 0.146 0.172 0.217 0.33
30
0.128 0.146 0.172 0.218 0.33
60
0.128 0.147 0.173 0.220 0.33
100 0.129 0.147 0.173 0.220 0.34
(ReliaSoftCorp)

WG

Watson G

Given a sample of n independent uniforms Ui over [0, 1],
the G statistic is defined by
Gn = (n)1/2max1 <= j <= n[j/n - U(j) + bar(U)n -1/2]
= (n)1/2(Dn+ + bar(U)n - 1/2),
where the U(j) are the Ui sorted in increasing
order, bar(U)n is the average of the observations Ui,
and Dn+ is the Kolmogorov-Smirnov+ statistic. The
distribution function (the cumulative probabilities) is
defined as Fn(x) = P[Gn <= x]
(Simard)

WU

Watson U

Given a sample of n independent uniforms ui over [0, 1],
the Watson statistic Un2 is defined by
Wn2 = 1/12n + ∑j=1n[u(j) - (j-0.5)/n]2,
Un2 = Wn2 - n(bar(u)n -1/2)2.
where the u(j) are the ui sorted in increasing order,
and bar(u)n is the average of the observations ui. The
distribution function (the cumulative probabilities) is
defined as Fn(x) =P[Un2 <= x]
(Simard)

From 2R Soft WG CDF code:

N
2
10
20
30
60
100
1000
10000

0.20
0.609
0.692
0.711
0.719
0.728
0.734
0.745
0.749

0.15
0.636
0.728
0.747
0.755
0.765
0.770
0.782
0.786

Significance
0.10
0.05
0.670 0.718
0.773 0.843
0.794 0.866
0.802 0.875
0.813 0.887
0.818 0.893
0.831 0.906
0.834 0.909

0.01
0.787
0.979
1.010
1.021
1.034
1.041
1.055
1.059

From 2R Soft WU CDF code:

N
2
10
20
30
60
100
1000
10000

0.20
0.122
0.116
0.116
0.117
0.117
0.117
0.117
0.117

0.15
0.132
0.130
0.131
0.131
0.131
0.131
0.131
0.131

Significance
0.10
0.05
0.143 0.154
0.150 0.183
0.151 0.185
0.151 0.185
0.151 0.186
0.152 0.186
0.152 0.187
0.152 0.187

0.01
0.164
0.255
0.262
0.264
0.266
0.267
0.268
0.268

STATISTICS
When appropriate, 2R Soft calculates an array of statistics that can be both relevant and pertinent for users
interested in analyzing the behavior of a data set.

The screenshot above is an example of what the user should expect to find in a Statistics tab. The following
subsections of this document explain each of the statistics that are calculated by 2R Soft.

MEAN
The arithmetic mean of a set of values is the quantity commonly called "the" mean or the average. Given a set of
samples * +, the arithmetic mean is: (Weisstein2)
̅

∑

VARIANCE
For a series of data, the sample variance may be computed as: (Weisstein3)
∑(

̅)

where ̅ is the sample mean.
Note that the sample variance defined above is not an unbiased estimator for the population variance, . In
order to obtain an unbiased estimator for , it is necessary to instead define a "bias-corrected sample variance":
(Weisstein3)
∑(

̅)

2R Soft uses the bias-corrected sample variance.
From the mathematical definition of variance, it is clear that this statistic expresses the dispersion of the data with
respect to the mean. The larger the variance, the more spread out is the data.

STANDARD DEVIATION
The standard deviation formula is very simple: it is the square root of the variance. It is the most commonly used
measure of spread (Lane2). Hence, an unbiased estimator of the population standard deviation, , is given by:

√

∑(

̅)

KURTOSIS
Kurtosis is a measure of whether the data are peaked or flat relative to a normal distribution. That is, data sets
with high kurtosis tend to have a distinct peak near the mean, decline rather rapidly, and have heavy tails. Data
sets with low kurtosis tend to have a flat top near the mean rather than a sharp peak. A uniform distribution would
be the extreme case. For univariate data Y1, Y2, ..., YN, the formula for kurtosis is: (SEMATECH3)
∑

̅)

(
(

)

where ̅ is the mean, is the standard deviation, and N is the number of data points.

SKEWNESS
Skewness is a measure of symmetry, or more precisely, the lack of symmetry. A distribution, or data set, is
symmetric if it looks the same to the left and right of the center point. For univariate data Y1, Y2, ..., YN, the formula
for skewness is: (SEMATECH3)
∑

̅)

(
(

)

where ̅ is the mean, is the standard deviation, and N is the number of data points. The skewness for a normal
distribution is zero, and any symmetric data should have a skewness near zero. Negative values for the skewness
indicate data that are skewed left and positive values for the skewness indicate data that are skewed right. By
skewed left, we mean that the left tail is long relative to the right tail. Similarly, skewed right means that the right
tail is long relative to the left tail. Some measurements have a lower bound and are skewed right. For example, in
reliability studies, failure times cannot be negative. (SEMATECH3)

QUARTILES (Q1, MEDIAN, Q3)
The quartiles of a data set are formed by the two boundaries on either side of the median, which divide the set
into four equal sections. The lowest 25% of the data being found below the first quartile value, also called the
lower quartile (Q1). The median, or second quartile divides the set into two equal sections. The lowest 75% of the
data set should be found below the third quartile, also called the upper quartile (Q3). These three numbers are
measures of the dispersion of the data, while the mean, median and mode are measures of central tendency.
(EncyclopediaOfStatistics)

BOX-WHISKER DIAGRAM
Given some data, a box and whisker diagram (or box plot) can be drawn to show the spread of the data. The
diagram shows the quartiles of the data, using these as an indication of the spread. (MathsRevision.net)
The diagram is made up of a "box", which lies between the upper and lower quartiles. The median can also be
indicated by dividing the box into two. (MathsRevision.net)
The "whiskers" are straight line extending from the ends of the box to the maximum and minimum values:
(MathsRevision.net)

In 2R Soft, the Box-Whisker diagram also contains a black dot, which marks the arithmetic mean of the generated
values.

ANOVA
Variance Analysis, also known as ANOVA, generally makes reference to a set of experimental situations and
statistical procedures for the analysis of quantitative answers of experimental units. The simplest problem tackled
by way of ANOVA is known as One-Way ANOVA, where the input data comes from sampling more than two
different populations and a single factor characterizes those populations (usually the mean). Meanwhile, Two-Way
ANOVA is employed when two factors of interest are in play and, as expected, it translates into a more complex
analysis. (Devore 1999)

ONE-WAY ANOVA
INTRODUCTION
Note: This section is based on (Devore 1999). Refer to that text for a more in-depth treatment of the topic.

NULL AND ALTERNATIVE HYPOTHESES
One-way ANOVA focuses on the comparison of two or more population means. Let:

Then:

If I=4, the null hypothesis is true if the four are identical.
would be true if, for example,
, if the four differ from each other, etc.

NOTATION
From this point on, we will be using the following notation:
Xij = the random variable representing the j-th measurement taken from the i-th population.
xij = the observed value of Xi,j when the experiment is carried out.
Ji = the sample size of the i-th population
n = ∑ = total number of observations in the ANOVA model
Individual sample means will be represented by ̅ , ̅ , … , ̅ . Thus:
∑

̅

In a similar way, the mean of all of the observations, called grand mean, is:
̅

∑

∑

, if

ASSUMPTIONS
Let us assume that the I populations are normally distributed with the same variance,
normally distributed with:
(

)

(

. That is, each Xij is

)

The standard deviations of the I samples (s1, s2, …, sI) will generally differ a bit even when the corresponding are
identical. In terms of sample standard deviations, s, a practical rule is: if the largest s isn’t much larger than twice
the value of the smallest, it’s reasonable to suppose equal .

TEST STATISTIC
If the null hypothesis is true, the Ji observations of every sample come from a normally distributed population with
the same mean , in which case the sample means ̅
̅ must be reasonably close to each other. The
testing procedure is based on the comparison of a measure of differences between the ̅ with a measure of
variation calculated within each one of the samples.
Let:
̅)

∑ ∑(
∑ ∑( ̅

̅)

Then, the mean square of treatments is given by:

And the mean square of error is:

The test statistic for one-way ANOVA is:

THE F TEST
When

is true:

Meanwhile, when

(

)

(

)

(

)

(

)

is false:

That is, both statistics are unbiased for estimating the common population variance
tends to overestimate
when
is false.

when

is true, but MSTr

When

is true and the basic ANOVA assumptions are satisfied, the F statistic has an F distribution with
and
. If the calculated value of F is represented by f, the rejection region
specifies an F-test with significance level of .

TUKEY PROCEDURE
When the calculated value of F, f, in a one-way ANOVA is outside the rejection region, the analysis ends because
no significant differences have been detected between the . On the other hand, when
is rejected, further
analysis can be made. Under such condition, it is useful to know which of the are dissimilar with one another.
The Tukey procedure provides the means to draw that sort of conclusions.
Let:
√

(

)

Where
is the critical upper tail value of the studentized distribution with I degrees of freedom in the
numerator and n-I degrees of freedom in the denominator, with significance level of .
Then,

is approximately the probability that:
̅

Any pair of sample means (̅

̅

̅

̅

̅ ) with a distance greater than

between them is -significantly different.

INPUT
In order to run a One-Way ANOVA analysis, the user must navigate through the Analysis menu and select the OneWay ANOVA option from the ANOVA submenu:

The user then needs to select the data series that will be treated as samples in the ANOVA analysis:




The series (or samples) are expected to be associated with separate populations or different treatments
of the same population.
The Alpha (%) parameter is the significance level, , to be used for both the F test and the Tukey
procedure (when appropriate).

OUTPUT
ANOVA TABLES
An ANOVA table is always the main result of an ANOVA analysis. A standard ANOVA table is summarized below:
Variation Source
Model (Samples)
Error
Total

Degrees of
Freedom
I-1
n-I
n-1

Sum of Squares

Mean Square

f

SSTr
SSE
SST

MSTr
MSE

MSTr / MSE

F_max
(rejection region limit)

Refer to the One-Way ANOVA Introduction section for information regarding the contents of the table.

WHEN NULL HYPOTHESIS CANNOT BE REJECTED
When the calculated value of F, f, in a one-way ANOVA is outside the rejection region, the analysis ends because
no significant differences have been detected between the . In this case, an ANOVA table is shown and nothing
else:

WHEN NULL HYPOTHESIS IS REJECTED
When the calculated value of F, f, in a one-way ANOVA falls inside the rejection region, the Tukey procedure is also
performed:

The Grouping and Series columns contain the most useful information from the first table. If two series have a
Grouping letter in common, they are NOT significantly different with significance level . In the example above,
series 2 and 3 aren’t significantly different, since they both contain the letter A in their Grouping. Meanwhile,
series 1 is significantly different from every other series, given that the grouping letter C doesn’t appear anywhere
else.
In the second table, conclusions regarding each pair of samples are explicitly shown. If the Sig. Dif.? column
indicates YES for a pair, the two samples are significantly different with significance level ; if it indicates NO, the
pair of samples isn’t significantly different with significance level . While the Dif. column shows the distance
̅ |, the Min. Sig. Dif. shows the Tukey minimum distance,
between the sample means, |̅
, for the two
series to be considered significantly different with significance level . Refer to the Tukey Procedure section for
more information on the meaning of these results.

TWO-WAY ANOVA
INTRODUCTION
Note: This section is based on (Devore 1999). Refer to that text for a more in-depth treatment of the topic.
One-Way ANOVA is used to test for similarity of population means. Nonetheless, many experiments deal with two
or more factors of interest. In Two-Way ANOVA, conclusions can be drawn regarding two factors, A and B. We use I
to represent the number of levels of factor A and J to represent the number of levels of factor B, for a total of IJ
possible combinations.
Due to the fact that 2R Soft aims for simplicity, the only type of Two-Way ANOVA analysis that can be
performed with this software suite is with datasets where Kij=1, being Kij the number of measurements made for
every combination (i,j) of factors A and B.

NOTATION
From this point on, we will be using the following notation:
Xij = the random variable representing the measurement when factor A is at level “i” and factor B is at level “j”.
xij = the observed value of Xi,j when the experiment is carried out.
I = number of levels of factor A.
J = number of levels of factor B.
∑

̅

∑

̅
The mean of all of the observations, called grand mean, is:
̅

∑

∑

THE MODEL
Suppose the existence of I parameters

and J parameters

such that:

(

∑

In the model,

)

∑

is the random quantity by which the measurement,

, differs from its predicted value (reality vs

model).
There are two hypotheses of interest in a Two-Way ANOVA:

The first hypothesis,
, states that the various levels of factor A have no effect over the real average measure;
the second hypothesis,
, rules out any effect from factor B.

TEST PROCEDURE
The test procedure here is very similar to the F Test carried out in a One-Way ANOVA. In Two-Way ANOVA, the
total variation is divided into the unexplained variability (or error), SSE, and into other two parts, SSA and SSB, that
can be explained by the possible falseness of the two null hypothesis,
and
respectively.
The calculations involved are:
∑ ∑(

̅)

∑ ∑( ̅

̅)

∑ ∑( ̅

̅)

(

)(

)
(

)(

)

F TEST
The resulting F test is:
Hypothesis

Test Statistic

Rejection Region
(

)(

)

(

)(

)

When

is true and the basic ANOVA assumptions are satisfied, the FA statistic has an F distribution with
and
(
)(
). If the calculated value of FA is represented by fA, the rejection region
specifies
an
F-test
with significance level of .
(
)(
)

When

is true and the basic ANOVA assumptions are satisfied, the FB statistic has an F distribution with
and
(
)(
). If the calculated value of FB is represented by fB, the rejection region
(
)(
) specifies an F-test with significance level of .

TUKEY PROCEDURE
When
or
are rejected, further analysis can be made. Under such condition, it is useful to detect important
differences between the levels of factor A or B in the samples. The Tukey procedure provides the means to draw
that sort of conclusions.
Let:
(

Where

)(

√

)

√
(
)(
)
{
is the critical upper tail value of the studentized distribution with x degrees of freedom in the

numerator and y degrees of freedom in the denominator, with significance level of .
Then,

is approximately the probability that:
̅

̅

̅

̅

̅

̅

̅

̅

Any pair of sample means with a distance greater than
the factor being studied (A or B).

between them is -significantly different in terms of

INPUT
In order to run a One-Way ANOVA analysis, the user must navigate through the Analysis menu and select the TwoWay ANOVA option from the ANOVA submenu:

This action opens a new graphical interface, which receives the sample data in a matrix that makes a 1-to-1
mapping between levels of factor A and levels of factor B:



The Alpha (%) parameter is the significance level, , to be used for both the F tests and the Tukey
procedures (when appropriate).

Two-Way ANOVA analysis uses a unique file format (.2ra) to save the data disjointedly from the one found in 2R
Data’s Main tab. For this reason, the Two-Way ANOVA window contains a separate File menu. Jump to the
Saving and Loading section for further information.

DATA EDITING FUNCTIONS
The following table summarizes the data input and modification procedures that are supported by the input
matrix:
Action
Add factor levels to the matrix

Modify a specific value of the
matrix

How To
5. To add a new factor A level to the matrix, select the last cell in the
B1 column (the one that is always blank). To add a new Factor B
level to the matrix, select the last cell in the A1 row (the one that is
always blank).
6. Write a value to be added.
7. Hit the ENTER key.
There are two ways of going about this task:
 Double-click over the cell that contains the value to be edited, make
the desired changes, and then hit the ENTER key.
 To overwrite a value, select the appropriate cell (single click) and
write the new value. Then, hit the ENTER key.

SAVING AND LOADING TWO-WAY ANOVA DATA
As mentioned before, the Two-Way ANOVA interface features its own, independent file management options to
save and load the data matrix along with the Alpha parameter.
To save the current data, select the Save option from the File menu in the Two-Way ANOVA Window:

The user is then prompted to select the file name and the folder in which to save the .2ra file.
On the other hand, to load a data file, select the Load option from the File menu in the Two-Way ANOVA Window:

The user is then prompted to select the .2ra file to be loaded.

OUTPUT
ANOVA TABLES
An ANOVA table is always the main result of an ANOVA analysis. A standard ANOVA table is summarized below:
Variation Source
Factor A
Factor B
Error
Total

Degrees of
Freedom
I-1
J-1
(I-1)(J-1)
IJ-1

Sum of Squares

Mean Square

SSA
SSB
SSE
SST

MSA
MSB
MSE

f

F_max
(rejection region limit)

MSA / MSE
MSB / MSE

Refer to the Two-Way ANOVA Introduction section for information regarding the contents of the table.

(

)(

)

(

)(

)

MAIN RESULTS
The main results after running the Two-Way ANOVA analysis are two statements regarding the rejection or
acceptance of the null hypotheses, along with an ANOVA table:

In the image shown above, the rejection of both hypotheses is explicitly stated.

TUKEY RESULTS
For every rejected null hypothesis, a Tukey procedure will be run with respect to the corresponding factor (A or B).
Then, a table will show the Tukey groupings with respect to that specific factor. The image below is an example of
a Tukey analysis with respect to Factor A:

The Grouping and Series columns contain the most useful information from the Tukey table. If two series have a
Grouping letter in common, they are NOT significantly different with significance level . In the example above,
series A5 and A4 aren’t significantly different, since they both contain the letter A in their Grouping. Meanwhile,
series A1 is significantly different from every other series, given that the grouping letter C doesn’t appear
anywhere else.
Refer to the Tukey Procedure section for more information on the meaning of these results.

DATA ANALYSIS
SINGLE SERIES ANALYSIS
As the name suggests, one particular series is the input for this type of analysis. No values are generated, so 2R
Data only focuses on the calculation of statistics and goodness-of-fit indicators associated with the selected series.
In order to run a Single Series Analysis, the user must navigate through the Analysis menu and select the Single
Series option from the Data Analysis submenu:

The user then has to select the series to be analyzed from a combo box and left-click over the OK button to start
the process:

Results are shown in three separate tabs: Normalized Hist., Cumulative Hist. and Statistics. Refer to the
Normalized and Cumulative Histograms and Statistics sections for more information on how to interpret those
results.

CORRELATION ANALYSIS
The correlation analysis is a 2-variable analysis that tests for linearity and dependence of one variable with respect
to another. To run this algorithm, a user must navigate through the Analysis menu and select the Correlation
option from the Data Analysis submenu:

A new dialog will open with all the possible 2-variable permutations that can be analyzed:

Warning: in this case, the order of the variables does matter. The results of the “y vs x” correlation analysis aren’t
necessarily equal to the ones obtained in an “x vs y” correlation analysis. The variable to the left is the dependent

variable, while the variable to the right is the independent variable. Consequently, 2R Data will try to express the
dependent variable in terms of the independent variable in purely linear terms, which will be explained in the
following sub-subsections.
A typical result screen for this analysis type is shown below:

In addition to a scatter plot with the dependent variable in the vertical axis and the independent variable in the
horizontal axis, 2R Data shows the Covariance and the Correlation Coefficient between the two variables as well
as the result from a linear regression and its corresponding Coefficient of Determination (R^2).

CORRELATION COEFFICIENT
The correlation coefficient is a single number between -1 and 1 that describes the dependence between two
variables. The formula used to compute the correlation coefficient of two variables from experimental data is
(Lane):

When two variables are independent from each other, their correlation coefficient is equal to 0. On the other
hand, if two variables are perfectly dependent, their correlation coefficient is equal to 1 (as one increases the
other one also increases) or -1 (as one increases the other one decreases, and vice-versa).

COVARIANCE
The difference between the covariance and the correlation coefficient is that the latter is a normalized value, while
the former is not. Hence, the correlation coefficient is more valuable when drawing conclusions, since the only
meaningful characteristic of a covariance is its sign (positive or negative). A positive covariance indicates that as
one variable increases the other one also increases, and a negative covariance indicates that as one variable
increases the other one decreases (and vice-versa). Mathematically:
(

)

(√

( )

( ))

(

) (PlanetMath)

Where cov is covariance, corr is correlation, and var is variance.

REGRESSION AND COEFFICIENT OF DETERMINATION
Essentially, regression analysis attempts to measure the correspondence between the dependent and independent
variables, thereby establishing the latter's predictive value. The proportion of unexplained variations is termed
the coefficient of determination. (Answers.com)
2

The coefficient of determination measures how good the estimated regression equation is, designated as R (read
as R-squared). The higher the R-squared, the more confidence one can have in the equation. Statistically, the
coefficient of determination represents the proportion of the total variation in the y variable that is explained by
the regression equation. It has the range of values between 0 and 1, where 1 is the ideal value (AllBusiness). It is
computed as:
∑(
∑(
Being

the real dataset and

)
̅)

the set of values predicted by the regression equation.

REGRESSION ANALYSIS
The regression analysis performed by 2R Data is exclusively a 2-variable analysis, although some software packages
are capable of running regressions with 3 or more variables. Its objective is to find an equation that explains one
variable in terms of another variable in a reliable way. To run this algorithm, the user must navigate through the
Analysis menu and select the Regression option from the Data Analysis submenu:

A new dialog will open with all the possible 2-variable permutations that can be analyzed:

Warning: in this case, the order of the variables does matter. The results of the “y vs x” regression analysis aren’t
necessarily equal to the ones obtained in an “x vs y” regression analysis. The variable to the left is the dependent
variable, while the variable to the right is the independent variable. Consequently, 2R Data will try to express the
dependent variable in terms of the independent variable.
A typical result screen for this analysis type is shown below:

The result contains a scatter plot with the dependent variable in the vertical axis and the independent variable in
the horizontal axis and two different tables: one with all the calculated regression equations ranked by coefficient
of determination and another one that displays the values of the parameters associated with the regression
selected in the first table. Additionally, the selected regression is drawn on top of the scatter plot (red curve).

REGRESSION AND COEFFICIENT OF DETERMINATION
Essentially, regression analysis attempts to measure the correspondence between the dependent and independent
variables, thereby establishing the latter's predictive value. The proportion of unexplained variations is termed
the coefficient of determination. (Answers.com)
2

The coefficient of determination measures how good the estimated regression equation is, designated as R (read
as R-squared). The higher the R-squared, the more confidence one can have in the equation. Statistically, the
coefficient of determination represents the proportion of the total variation in the y variable that is explained by
the regression equation. It has the range of values between 0 and 1, where 1 is the ideal value (AllBusiness). It is
computed as:
∑(
∑(
Being

is the real dataset and

)
̅)

the set of values predicted by the regression equation.

PARAMETERS AND THEIR STATISTICS
Although the coefficient of determination is a good statistic for ranking purposes, the acceptance of a regression
should also take the parameters and their related errors into account. The following table explains the different
statistics that 2R Data calculates for each estimated parameter in a regression equation:
Statistic
Std. Error
t-value

Description
Standard deviation estimate of the best estimate of the parameter.
A one sample t-test is a hypothesis test for answering questions about the mean where the
data is a random sample of independent observations from an underlying normal
distribution N(µ, ), where
is unknown.
The null hypothesis for the one sample t-test is:
H0: µ = µ0, where µ0 is known.
That is, the sample has been drawn from a population of given mean and unknown variance
(which therefore has to be estimated from the sample).
This null hypothesis, H0 is tested against one of the following alternative hypotheses,
depending on the question posed:
H1: µ is not equal to µ
H 1: µ > µ
H 1: µ < µ
(McColl)
The t-value for acceptance depends on the confidence level of the test (see table below). If
the calculated t is greater than value shown, reject the null hypothesis: (ANU)

p-value

The probability value (p-value) of a statistical hypothesis test is the probability of getting a
value of the test statistic as extreme as or more extreme than that observed by chance
alone, if the null hypothesis H0, is true.
It is the probability of wrongly rejecting the null hypothesis if it is in fact true.
It is equal to the significance level of the test for which we would only just reject the null
hypothesis. The p-value is compared with the actual significance level of our test and, if it is
smaller, the result is significant. That is, if the null hypothesis were to be rejected at the 5%
significance level, this would be reported as "p < 0.05".
Small p-values suggest that the null hypothesis is unlikely to be true. The smaller it is, the
more convincing is the rejection of the null hypothesis. It indicates the strength of evidence
for say, rejecting the null hypothesis H0, rather than simply concluding "Reject H0' or "Do not
reject H0".
(McColl)

FILTERS
2R Data tries out over 6,000 different equation forms during a regression analysis. If a user is interested in a
particular subset of such equation forms, he can filter out unwanted types of regressions by using the View menu
and deselecting the appropriate checkboxes.

2

The table containing regressions ranked by coefficient of determination (R ) will only show equations of the types
that are ticked in the View menu.

TYPES OF EQUATION FORMS
The table shown below summarizes the characteristics of each of the equation forms that can be filtered out
through 2R Data’s View menu.
Equation Type
Complex Linear

Corresponding Equation Forms
Linear combinations with 4 or more unknown coefficients (including the constant term).
Example:
-1.5
-1.5*x
a+b*x +c*e
+d*ln(x)
where x is the independent variable and a, b, c, and d are unknown parameters.

Non-Linear

Any equation in which an unknown parameter plays a role different from being a
coefficient in a linear combination.
Example:
b*x
a*e
where x is the independent variable and a and b are unknown parameters. Clearly, b is
playing a role different from a linear coefficient, such as a.

Polyexponential

∑
where x is the independent variable and ai are unknown coefficients.
Example:
x
2*x
3*x
a+b*e +c*e +d*e
where x is the independent variable and a, b, c, and d are unknown parameters.

Polylogarithmic

∑

, ( )-

where x is the independent variable and ai are unknown coefficients.
Example:
2
3
a+b*ln(x)+c*[ln(x)] +d*[ln(x)]
where x is the independent variable and a, b, c, and d are unknown parameters.
Polynomial

∑
where x is the independent variable and ai are unknown coefficients.
Example:
2
3
a+b*x+c*x +d*x
where x is the independent variable and a, b, c, and d are unknown parameters.

Simple Linear

Linear combinations with less than 4 unknown coefficients (including the constant term).
Example:
-1.5*x
a+b*e
where x is the independent variable and a and b are unknown parameters.

DATA MANIPULATION
BOOTSTRAP ANALYSIS
Unlike the Single Series analysis, the Bootstrap algorithm does involve generating values before calculating
statistics and goodness-of-fit indicators. Bootstrapping is a resampling method. The idea: We have just one
dataset. When we compute a statistic on the data, we only know that one statistic -- we don't see how variable
that statistic is. The bootstrap creates a large number of datasets that we might have seen and computes the
statistic on each of these datasets. Thus we get a distribution of the statistic. Key is the strategy to create data that
"we might have seen" (BurnsStatistics).
The algorithm that 2R Data runs for bootstrapping is summarized below: (let N be the number of bootstrap
iterations to be executed on the dataset and let M be the number of data values in the dataset)

Given that every bootstrap iteration is completely independent from the rest, 2R Data can speed up this processorintensive algorithm with the use of a thread pool, which can execute various iterations in parallel if more than one
CPU core is present.

Important: in 2R Data’s Bootstrap analysis, the mean of the series is the statistic being studied, as can be seen in
the flow chart above. Therefore, all the resulting statistics and goodness-of-fit indicators make reference to the
mean of the dataset and not the dataset itself.
To begin a Bootstrap analysis of the mean of a data series, the user must navigate through the Analysis menu and
select the Bootstrap option from the Data Manipulation submenu:

Afterwards, the user is prompted to select the appropriate series and enter the number of bootstrap iterations to
be executed, N, before the algorithm begins.
Results are shown in three separate tabs: Normalized Hist., Cumulative Hist. and Statistics. Refer to the
Normalized and Cumulative Histograms and Statistics sections for more information on how to interpret those
results.

CLUSTERING ANALYSIS
In the words of (Dipartimento Di Elettronica E Informazione):
Clustering can be considered the most important unsupervised learning problem; so, as every other problem of
this kind, it deals with finding a structure in a collection of unlabeled data. A loose definition of clustering could be
“the process of organizing objects into groups whose members are similar in some way”. A cluster is therefore a
collection of objects which are “similar” between them and are “dissimilar” to the objects belonging to other
clusters. We can show this with a simple graphical example:

INTRODUCTION TO CLUSTERING ALGORITHMS
Clustering algorithms can be classified into 4 different groups (Dipartimento Di Elettronica E Informazione):
1.

Exclusive clustering: if a certain datum belongs to a definite cluster then it could not be included in
another cluster.
Overlapping clustering: uses fuzzy sets to cluster data, so that each point may belong to two or more
clusters with different degrees of membership.
Hierarchical clustering: based on the union between the two nearest clusters. The beginning condition is
realized by setting every datum as a cluster. After a few iterations it reaches the final clusters wanted.
Probabilistic clustering: a completely probabilistic approach.

2.
3.
4.

An important step in any clustering is to select a distance measure, which will determine how the similarity of two
elements is calculated. This will influence the shape of the clusters, as some elements may be close to one another
according to one distance and farther away according to another (Temporis). Common distance measures include
the Euclidean distance, Manhattan distance, Mahalanobis distance, and Hamming distance. In the case of 2R Soft,
Euclidean distance is always used as the distance measure during clustering analysis.

EUCLIDEAN DISTANCE
(

If

) and

(
(

), the Euclidean distance from a to b is defined as:
)

√(

)

(

)

(

)

Geometrically, the result is equal to the length of the segment joining a and b.

DENDROGRAM / HIERARCHICAL CLUSTERING
Given a set of N items to be clustered and an N*N distance (or similarity) matrix, the basic process of hierarchical
clustering defined by (Johnson 1967) is:
1.

2.
3.
4.

Start by assigning each item to a cluster, so that if you have N items, you now have N clusters, each
containing just one item. Let the distances (similarities) between the clusters the same as the distances
(similarities) between the items they contain.
Find the closest (most similar) pair of clusters and merge them into a single cluster, so that now you have
one cluster less.
Compute distances (similarities) between the new cluster and each of the old clusters.
Repeat steps 2 and 3 until all items are clustered into a single cluster of size N.

Step 3 can be done in different ways, which is what distinguishes the various clustering algorithms (single linkage,
complete linkage, etc) from each other.
Jump to the Running a Clustering Analysis in 2R Soft section to learn how to run Hierarchical Clustering algorithms
on 2R Data datasets.

K-MEANS CLUSTERING
K-Means is an exclusive clustering algorithm for partitioning N data points into K disjoint subsets Sj containing Nj
data points so as to minimize the sum-of-squares criterion (Weisstein):
∑ ∑|

Where

is a vector representing the nth data point and

|

is the geometric centroid (average of all coordinates)

of the data points in Sj.
The algorithm consists on a simple re-estimation procedure as follows (Weisstein). Initially, the data points are
assigned at random to the K sets.




For step 1, the centroid is computed for each set.
In step 2, every point is re-assigned to the cluster whose centroid is closest to that point.
These two steps are alternated until a stopping criterion is met, i.e., when there is no further change in
the assignment of the data points.

Jump to the Running a Clustering Analysis in 2R Soft section to learn how to run the K-means algorithm on 2R Data
datasets.

K-MEDOIDS CLUSTERING
K-medoids is a clustering algorithm that is very much like k-means. The main difference between the two
algorithms is the cluster center they use. K-means uses the average of all instances in a cluster, while k-medoids
uses the instance that is the closest to the mean, i.e. the most 'central' point of the cluster. Using an actual point of
the data set to cluster makes the k-medoids algorithm more robust to outliers than the k-means algorithm. (Abeel)
Jump to the Running a Clustering Analysis in 2R Soft section to learn how to run the K-medoids algorithm on 2R
Data datasets.

SPECTRAL CLUSTERING
Note: This sub-section is based on (Nugent and Stanberry). Refer to that source for a more in-depth treatment of
the topic.
Spectral clustering algorithms partition points using eigenvectors of matrices derived from the data. They obtain a
data representation in the low-dimensional space that can be easily clustered and a variety of methods exist that
use the eigenvectors differently.
2R Soft uses the NJW (Ng, Jordan, and Weiss) algorithm.

NJW ALGORITHM
*

Motivation: Given a set of points
1.

Form the affinity matrix
similarity:

+

, we would like to cluster them into k subsets:

by applying a kernel (Gaussian, Inverse Quadratic, etc) to a measure of

With Gaussian Kernel:
‖

‖

{

With Inverse Quadratic Kernel:

√‖

‖

{
In both cases, ‖
‖ stands for a basic measure of similarity. If ‖
‖ is large, points and are
said to be “closer” to each other in accordance with the distance measure being used. In 2R Soft,
Euclidean Distance is the unit measure employed, so the result of ‖
‖ is taken to be the INVERSE
of that distance. More distance between two points leads to a lower ‖

‖ (similarity).

2.

Define D a diagonal matrix whose (i,i) element is the sum of A’s row i:

3.

Form the matrix L, where:

4.

Stack the k largest eigenvectors of L to form the columns of the new matrix X.

5.

Renormalize each of X’s rows to have unit length. The result of this operation is matrix Y:

6.

Cluster the rows of matrix Y as points in R via K-means.

7.

For every i, assign point

k

to cluster j iff row i of Y was assigned to cluster j.

The answer to “If we eventually use K-means, why not just apply K-means to the original data?” is that this method
allows us to cluster non-convex regions:

Jump to the Running a Clustering Analysis in 2R Soft section to learn how to run the NJW Spectral Clustering
algorithm on 2R Data datasets.

RUNNING A CLUSTERING ANALYSIS IN 2R SOFT
To begin a clustering analysis in 2R Data, the user must navigate through the Analysis menu and select the
Clustering option from the Data Manipulation submenu:

INPUT
The input window’s options vary depending on the algorithm to be used and on whether or not the user plans to
perform a multi-level clustering. This section covers each region of the window separately.

CLUSTERING DIMENSIONS

In this region of the input window, the user must select the data series that will be part of the clustering analysis.
Each selected series will act as a unique space dimension. In the example above, series S2 and S3 are selected, so
point xi will be taken to be a 2-dimensional coordinate (S2i, S3i) for every row “i” of data.

ALGORITHM

The algorithm dictates how clustering is to be carried out and the type of results that will be shown. Click on the
name of a specific algorithm to be redirected to the section of this document that explains the logic behind it:



Dendrogram/Hierarchical: a dendrogram is generated as the final result. Jump to the Dendrogram section
for more information.
K-Means, K-Medoids and Spectral: a tree structure will show the resulting arrangement of clusters and
their members. The options to analyze a specific cluster and to graph a 2-dimensional or 1-dimensional
cluster are also provided. Jump to the Tree View section for more information.

PARAMETERS (FOR K-MEANS, K-MEDOIDS AND SPECTRAL)
When running a one-level clustering analysis, meaning that clusters are only calculated from the source data and
no sub-clusters within those clusters are to be calculated, a single parameter has to be entered:



# Clusters: the number of clusters that the user wants to obtain from the clustering process.

MULTI-LEVEL CLUSTERING
If sub-clusters within clusters are to be calculated, the user will have to activate the Multi-Level Clustering
checkbox. This will require additional information to be entered in the Multi-Level region of the clustering
window:



Unsupervised Multi-Level: for each calculated cluster, sub-clusters will be found until a point is reached
where the sub-sub-…-sub-cluster cannot be divided into #Clusters clusters (5 in the screen above).
Therefore, for the example above, a tree of clusters is obtained in which each “node” (cluster) has either 0
or 5 “nodes” (clusters) as childs.



Predefined # of Levels: this type of multi-level clustering stops after N levels of clusters are found (limited
depth of search). For each calculated cluster, sub-clusters will be found until a point is reached where the
sub-sub-…-sub-cluster cannot be divided into #Clusters clusters (5 in the screen above) or until N levels of
clusters have already been calculated. Therefore, for the example above, a tree of clusters is obtained in
which each “node” (cluster) has either 0 or 5 “nodes” (clusters) as childs, and the maximum depth of
search is of sub-sub-clusters with respect to the original clusters.

KERNEL (SPECTRAL ONLY)
The Kernel region is displayed when the Spectral algorithm is selected.

For information on what the Kernel does and on the effects of “sigma” and “c”, refer to the Spectral Clustering
section.

OUTPUT
DENDROGRAM (HIERARCHICAL ONLY)
When a hierarchical clustering analysis is performed, a dendrogram is the end result. A new window will become
visible with a variety of options. For option changes to take effect, the “Update” button must be used.









Clustering algorithm: this setting dictates how distances are computed on step 3 of the clustering
algorithm.
Precision: the amount of decimal places to use in the axis.
Tree
o Tree Orientation: defines the direction in which the dendrogram is generated.
o Show bands: when selected, bands are displayed to indicate the level of heterogeneity inside the
clusters.
Nodes
o Nodes size: the size of the dendrogram terminations.
o Show labels: the numerical value of each termination is shown when this is selected.
o Labels Orientation: the direction in which the labels are to be displayed.
Axis
o Show axis: the value axis is shown when this is selected.
o Show labels: the axis is complemented with labels when this is enabled.

TREE VIEW (FOR K-MEANS, K-MEDOIDS AND SPECTRAL)
After a non-hierarchical clustering analysis is run, the results are displayed in the form of a tree view:

Nodes with a folder icon (clusters and members) can be expanded and contracted by double-clicking on them.
Every cluster contains:




The average distance between pairs of data points inside the cluster (<dist.>).
A Members folder with a list of all the data points that comprise the cluster.
A list of sub-clusters when applicable (if running a multi-level clustering).

The tree view provides 4 important options. They are applied on the selected cluster only. The selected cluster is
the one highlighted by the user by clicking on it.


Graph Real: a graph of the selected cluster’s data points is shown (only for 2-D and 1-D analyses). The
members of a cluster are represented with a unique shape and color.



Graph Fictitious: a graph of the selected cluster’s sub-clusters is generated, where each sub-cluster is
represented as a single data point corresponding to its geometric centroid. Every sub-cluster’s geometric
centroid is graphed with a unique shape and color.



Analyze Real: the selected cluster’s data points are exported to a new 2R Data window for further
analysis.
Analyze Fictitious: the selected cluster’s sub-clusters are exported to a new 2R Data window for further
analysis, where each sub-cluster is represented as a single data point corresponding to its geometric
centroid.



PCA ANALYSIS (PRINCIPAL COMPONENT ANALYSIS)
PCA is a way of identifying patterns in data, and expressing the data in such a way as to highlight their similarities
and differences. Since patterns in data can be hard to find in data of high dimension, where the luxury of graphical
representation is not available, PCA is a powerful tool for analyzing data. The other main advantage of PCA is that
once you have found these patterns in the data, and you compress the data by reducing the number of
dimensions, without much loss of information. (Smith)
The PCA algorithm is comprised by the following steps:
1.

2.
3.
4.

Arrange the data in a matrix, where each column represents a data dimension (a separate dataset, such
as a sensor’s readings) and each row represents a data value for each dimension. Clearly, all the
dimensions must contain the same amount of observations.
Subtract the mean across each dimension. For example, the mean of the values in the nth column is
calculated and then subtracted from each of the values in that same column.
Calculate the covariance matrix, such that the cell (i,j) contains the covariance between dimension i and
dimension j. The resulting covariance matrix must be symmetric
Calculate the eigenvalues and eigenvectors of the covariance matrix.

Let A be a linear transformation represented by a matrix A. If there is a vector
such that
some scalar , then is called the eigenvalue of A with corresponding (right) eigenvector X. (Weisstein4)
5.

Choose components and form a feature vector. Once eigenvectors are found from the covariance matrix,
the next step is to order them by eigenvalue, highest to lowest. This gives you the components in order of
significance. Now, if you like, you can decide to ignore the components of lesser significance. You do lose
some information, but if the eigenvalues are small, you don’t lose much. If you leave out some
components, the final data set will have fewer dimensions than the original. To be precise, if you originally
have dimensions in your data, and so you calculate eigenvectors and eigenvalues, and then you choose
only the first eigenvectors, then the final data set has only dimensions. What needs to be done now is you
need to form a feature vector, which is just a fancy name for a matrix of vectors. This is constructed by
taking the eigenvectors that you want to keep from the list of eigenvectors, and forming a matrix with
these eigenvectors in the columns. (Smith)
_

_

{

{

(

6.

for

)

Calculate the transformed values.

RowFeatureVector is the FeatureVector transposed, while RowDataAdjust is the mean-adjusted data
transposed. (Smith)
The final data obtained gives the original data solely in terms of the eigenvectors that were chosen in the
previous step. If the amount of dimensions of the transformed data is less than the original amount of
dimensions, some data is lost, but the most significant features are retained in the new dimensions.

PCA IN 2R DATA
To start a PCA analysis in 2R Data, the user must have declared two or more data series with the same amount of
data points. Then, the PCA option under the Data Manipulation submenu of the Analysis menu can be invoked:

A new screen will appear for the user to indicate the series to be included in the analysis, the matrix to be used for
the analysis, and the criteria that should be used for selecting the eigenvalues:

The first two inputs (series to analyze and analysis matrix) are self-explanatory. It should be noted that the
covariance matrix is the default analysis matrix. The eigenvalue criteria are explained below:
Criterion
Eigenvalues greater than 1

Explanation
In essence this is like saying that, unless a factor extracts at least as much as
the equivalent of one original variable, we drop it. (StatSoft)

Cumulative percentage

Predefined number of eigenvalues

The user enters the minimum percentage of the data that should be
explained by the new dimensions. Thus, 2R Data retains eigenvalues until
the cumulative loading percentage is greater than or equal to such
percentage.
If the user expects a specific amount of dimensions for the transformed
data, 2R Data will retain that number of eigenvalues during the analysis.

After setting up the PCA analysis and pressing the Start button, the user is presented with a variety of results:

Note: The retained eigenvalues are highlighted with yellow in the visual interface.

Result
Correlation Matrix
Covariance Matrix
Eigenvalues
Eigenvectors
Original Loading Factors

New Loading Factors

Transformed Data
SPE

Explanation
The correlation matrix, such that the cell (i,j) contains the correlation between
dimension i and dimension j
The covariance matrix, such that the cell (i,j) contains the covariance between
dimension i and dimension j.
Eigenvalues of the analysis matrix (covariance or correlation matrix, depending on
what the user chose in the PCA analysis settings screen).
Eigenvectors of the analysis matrix (covariance or correlation matrix, depending on
what the user chose in the PCA analysis settings screen).
Correlations between observed variables and factors. The unrotated factor loading
matrix is the matrix product of the eigenvector with the square root of the eigenvalue
matrix. (Pickering)
Loading factors after a varimax rotation. Varimax maximises the variance of loadings
within factors across variables (simplifies factors: some variables have high loadings,
others have low). (Pickering)
Data points in the new dimensions, where PCAN is associated with the nth most
significant eigenvalue.
Let
denote a sample vector of m sensors. Assuming that there are N samples
for each sensor, a data matrix
is composed with each row representing a
sample. The matrix X is scaled to zero mean for covariance-based PCA and, in
addition, to unit variance for correlation-based PCA. The matrix X can be decomposed
into a score matrix T and a loading matrix P by either the NIPALS or the singular value
decomposition (SVD) algorithm: (Qin 2003)

The SPE index measures the projection of the sample vector on the residual subspace:
(Qin 2003)

The process is considered normal if
where
limit for SPE with a significance level . (Qin 2003)

2

T

denotes the upper control

2

Hotelling’s T statistic measures variations in the PCS: (Qin 2003)
,
Under the condition that the process is normal and the data follow a multivariate
normal distribution, the T2 statistic is related to an F distribution considering that the
population mean and covariance are estimated from data: (Qin 2003)

where Fl;N-l is an F distribution with l and N-l degrees of freedom. For a given
significance level the process is considered normal if: (Qin 2003)

Bounds

2

Upper control limits for SPE and T with different significance levels.

FACTORS VS COMPONENTS
2R Data performs Factor Analysis in parallel with the PCA Analysis. The differences between factors and
components are: (Pickering)








Factor Analysis (FA) gives factors; PCA yields components.
Same overall stages.
Differ in the variance that is analyzed.
PCA: all variance of observed variables (shared; unique; and error) is analyzed.
FA: only shared variance is analyzed.
Theoretically, factors are the underlying (latent) variables that CAUSE the covariation between observed
variables. The labels for factors are attempts to name these causal latent variables.
Components are just empirically determined aggregates of the variables without presumed theory. Labels
are used but they are just a short-hand for the component.

TIME SERIES
Time series are used to keep record of the evolution of a specific measure as time passes by. Their analysis has
been the topic of research for a long time and has resulted in entire books dedicated to that topic. Given that 2R
Soft aims for simplicity, 2R Data only supports fixed-interval time series, meaning that the time elapsed
between one measurement and its adjacent values is always the same.

AUTO-CORRELATION
THEORY
When the correlation is calculated between a series and a lagged version of itself it is called autocorrelation. A
high correlation is likely to indicate a periodicity in the signal of the corresponding time duration.
The correlation coefficient at lag k of a series x0, x1, x2,....xN-1 is normally given as (Bourke 1996):

Where mx is the mean of the series. When the term i+k extends past the length of the series N two options are
available. The series can either be considered to be 0 or in the usual Fourier approach the series is assumed to
wrap, in this case the index into the series is (i+k) mod N. The denominator in the expression above serves to
normalize the correlation coefficients such that -1 <= autocorr(k) <= 1, the bounds indicating maximum correlation
and 0 indicating no correlation. A high negative correlation indicates a high correlation but of the inverse of the
lagged series (Bourke 1996).

INPUT
To begin an auto-correlation analysis, the user must navigate through the Analysis menu and select the AutoCorrelation option from the Time Series submenu:

A new window will pop up:








Time Series: the fixed-interval time series that will be analyzed.
Maximum Delay: the maximum lag to be used for the analysis in terms of measurement intervals. For
example, if the value entered is 3, the auto-correlation function will test lag values of -3,-2,-1,0,1,2, and 3
to calculate the desired correlogram (or auto-correlation series).
No Data Wrapping: as mentioned in the Theory section, the lagged series will go past the maximum term
in the original series. If no data wrapping is used, the value for all points beyond the maximum term will
be taken to be zero (0).
Circular Series: as mentioned in the Theory section, the lagged series will go past the maximum term in
the original series. If a circular series is used, the series becomes a periodic series with period N, where N
is the length of the original series. Thus, it will start over right after the maximum term.

OUTPUT
2R Data will show 3 results when the calculations are finished:


A table with the auto-correlation value, r, for every amount of delay. This table can be exported to Excel.



A graph showing the original time series.



A correlogram (or auto-correlation series) graphically showing the auto-correlation values as a function of
lag. The maximum and minimum auto-correlations are explicitly pointed out below the correlogram.

CROSS-CORRELATION
THEORY
Cross correlation is a standard method of estimating the degree to which two series are correlated. Consider two
series x(i) and y(i) where i=0,1,2...N-1. The cross correlation, r, at delay d is defined as (Bourke 1996):

Where mx and my are the means of the corresponding series. If the above is computed for all delays d=0,1,2,...N-1,
then it results in a cross correlation series of twice the length as the original series (Bourke 1996).
There is the issue of what to do when the index into the series is less than 0 or greater than or equal to the number
of points (i-d < 0 or i-d >= N). The most common approaches are to either ignore these points or assuming the
series x and y are zero for i < 0 and i >= N. In many signal processing applications the series is assumed to be
circular in which case the out of range indexes are "wrapped" back within range, ie: x(-1) = x(N-1), x(N+5) = x(5)
(Bourke 1996).
The range of delays d and thus the length of the cross correlation series can be less than N, for example the aim
may be to test correlation at short delays only. The denominator in the expression above serves to normalize the
correlation coefficients such that -1 <= r(d) <= 1, the bounds indicating maximum correlation and 0 indicating no
correlation. A high negative correlation indicates a high correlation but of the inverse of one of the series (Bourke
1996).

INPUT
To begin a cross-correlation analysis, the user must navigate through the Analysis menu and select the CrossCorrelation option from the Time Series submenu:

A new window will pop up:








Time Series: the two fixed-interval time series that will be juxtaposed.
Maximum Delay: the maximum lag to be used for the analysis in terms of measurement intervals. For
example, if the value entered is 3, the cross-correlation function will test lag values of -3,-2,-1,0,1,2, and 3
to calculate the desired cross-correlation series.
No Data Wrapping: as mentioned in the Theory section, the lagged series will go past the maximum term
in the original series. If no data wrapping is used, the value for all points beyond the maximum term will
be taken to be zero (0).
Circular Series: as mentioned in the Theory section, the lagged series will go past the maximum term in
the original series. If a circular series is used, the series becomes a periodic series with period N, where N
is the length of the original series. Thus, it will start over right after the maximum term.

OUTPUT
2R Data will show 3 results when the calculations are finished:


A table with the cross-correlation value, r, for every amount of delay. This table can be exported to Excel.



Graphs showing the original time series.



A cross-correlation plot graphically showing the cross-correlation values as a function of lag. The
maximum and minimum cross-correlations are explicitly pointed out below the cross-correlation plot.

FOURIER TRANSFORM
THEORY
Note: this section is based on (Handley 2007). Refer to that text for a more in-depth treatment of the topic.

FOURIER SERIES
Any periodic function can be expressed as the sum of a series of sines and cosines (of varying amplitudes). A
function f(x) can be expressed as a series of sines and cosines:

Where:

,

,

,

FOURIER TRANSFORM
Fourier Series can be generalized to complex numbers, and further generalized to derive the Fourier Transform.
Forward Fourier Transform:

,
Fourier Transform maps a time series (e.g. audio samples) into the series of frequencies (their amplitudes and
phases) that composed the time series.
If we wish to find the frequency spectrum of a function that we have sampled, the continuous Fourier Transform is
not so useful. We need a discrete version:
Discrete Forward Fourier Transform:

, so the complex numbers f0 … fN are transformed into complex numbers F0 … Fn.

INTERPRETATION


The magnitude of the complex number for a DFT component is the power at that frequency.

INPUT
To begin a Fourier Transform analysis, the user must select the Fourier Transform option found under the Time
Series submenu of the Analysis menu:

The program then asks the user to select the series that is to undergo a Fourier analysis:



Time Series: the fixed-interval time series that will be analyzed.

OUTPUT
In the results, the variable f_s is used to represent the sampling frequency (samples per unit of time), which
should be known by the user. The calculated series covers frequencies between 0 and f_s.


The first result is a table showing the real and imaginary components for the different frequencies, along
with the associated intensities (img^2+real^2). This data can be easily exported to Excel for further
analysis.



4 graphs are also generated: one showing the original series, and the other three showing the real
components, imaginary components, and associated intensities of the various frequencies:

MOVING AVERAGE
THEORY
Inherent in the collection of data taken over time is some form of random variation. There exist methods for
reducing of canceling the effect due to random variation. An often-used technique in industry is "smoothing". This
technique, when properly applied, reveals more clearly the underlying trend, seasonal and cyclic components
(SEMATECH). Moving Average is a popular smoothing method. It computes the mean of successive smaller sets of
past data. The general expression for the moving average is:
Mt = [ Xt + Xt-1 + ... + Xt-N+1] / N, where N is the size of the smaller sets of past data.
Here’s an example of a Moving Average when N=3:

Point
1
2
3
4
5
6
7
8
9
10
11
12

Value
9
8
9
12
9
12
11
7
13
9
11
10

MA
9
8.5
8.67
9.67
10.00
11.00
10.67
10.00
10.33
9.67
11.00
10.00

E.g. M6=(X6+X5+X4)/3=(12+9+12)/3=33/3=11
Note that the first two data points don’t have 2 values before them to take into account, so they only consider the
average of the available values.

INPUT
To begin a Moving Average analysis, the user must select the Moving Average option found under the Time Series
submenu of the Analysis menu:

The user is prompted for some information:





Time Series: the fixed-interval time series that will be analyzed.
Averaging Period: the size of the smaller sets of past data. Refer to the Theory section for details.
Initial Skip Period: the point from which the moving average series will begin. E.g. If the initial skip period
is X, the moving average series starts at t=X.

OUTPUT


A table shows the moving average value for every point in the analysis range. This data can be easily
exported to Excel for further analysis.



The results are also plotted. The moving average is shown in BLUE, while the original series is displayed in
RED. Note that the random variations are reduced in the moving average series.

EXAMPLES
EXAMPLE 1 – INTERNATIONAL EXAM – SINGLE SERIES ANALYSIS
An organization in charge of an international exam, such as the TOEFL or the GRE, has received all of the candidate
scores for one season and wants to define the different grade bounds to be able to send the score reports to the
test-takers. The final result for each candidate is expressed as a numeric value between 1 and 9 and the
organization has decided that, given the size of the population, the fairest method to define the grade bounds is to
fit a normal distribution to the sample and take predefined percentiles as the grade bounds.
The exam scores range from 0 to 430 and the sample data can be found in the Example 1 data model.
The results of a single-series analysis over the Example 1 data model are shown below:

The best-fit normal distribution (red curve in graphs above) has a mean score of 295.69 and standard deviation of
76.93. Consequently, the grade bounds can now be calculated:
Final Grade
1
2
3
4
5
6
7
8
9

Grade Bound Description
th
Lower than 20 percentile
th
th
20 percentile to 30 percentile
th
th
30 percentile to 40 percentile
th
th
40 percentile to 50 percentile
th
th
50 percentile to 60 percentile
th
th
60 percentile to 70 percentile
th
th
70 percentile to 80 percentile
th
th
80 percentile to 90 percentile
th
90 percentile or higher

Lower Bound
0
231
255
276
296
315
336
360
394

Upper Bound
231
255
276
296
315
336
360
394
430

EXAMPLE 2 – ADMISSIONS OFFICE - BOOTSTRAPPING
A university’s admissions office wants to calculate a confidence interval with
for the amount of students
that send applications to enter the Civil Engineering major each semester. The Civil Engineering Faculty opened 10
years ago, so they only have 20 data points to carry out the analysis, which are included in the Example 2 data

model. After conducting a Bootstrap analysis with 10,000 iterations, the admissions office obtained the following
results:

The probability distribution with the best (lowest) Anderson-Darling statistic is a Gamma distribution with an alpha
parameter of 991.58 and a lambda parameter of 11.83. Thus, a confidence interval with
is that between
th
th
the 5 percentile and the 95 percentile of such distribution:
Confidence Interval = [79, 88] applications per semester

EXAMPLE 3 – INFLATION AND UNEMPLOYMENT RATES – CORRELATION
According to the Phillips Curve, the rate of inflation and the unemployment rate follow an inverse relationship
(when one is high the other one is low, and vice-versa). To test this theory in practice, a student has decided to
analyze the correlation between the two macroeconomic measurements (unemployment and inflation) in
Colombia with historic data from the past 10 years. The Example 3 data model contains such information.
After running a correlation analysis over the Example 3 data model for inflation rate vs unemployment rate, the
student obtained the results shown below:

The correlation coefficient (0.411) indicates that there is a positive correlation between the two data series, which
is exactly the opposite of what was expected. Such relation between inflation and unemployment rates isn’t linear,
2
since the determination coefficient (R ) for the linear regression, 0.169, is nowhere near 1.0. Therefore, one can
conclude that Colombia’s economy doesn’t hold true to what the Phillips Curve states, and that the relation
between these two variables must be non-linear.

EXAMPLE 4 – WORLD POPULATION - REGRESSION
A student wants to estimate the global population by the year 2020 based on world population data from the past
10 years. The Example 4 data model contains the input data for this estimate.
The result of a regression analysis over the Example 4 model is shown below:

The regression is carried out in the form “GLOBAL POP. vs YYYY”, taking into account that time is the independent
variable and population is the dependent variable. According to the screenshot above, a second-degree polynomial
2
regression fits the data with a determination coefficient (R ) of 1.0, so it can be used as the base regression for the
2
subsequent analysis. Not only does the equation “GP=-75638459904.48+5469855.96*Y+17696.05*Y ” explain the
dependence of global population with time; it also expresses a coherent behavior (always increasing, faster than
linear, etc).
To estimate the world population by the year 2020, one must replace “Y” for “2020” in the regression equation:
2

GP(2020)=-75638459904.48+5469855.96*2020+17696.05*2020 = 7,617,611,555 people

EXAMPLE 5 – TEMPERATURE SENSORS - PCA
A meteorologist has recollected historic temperature measurements with the help of 4 sensors spread along a
small village. Given that temperature differs slightly within a specific geographic region, the meteorologist expects
the 4 sensors to share around 80% of data in common and wants to be able to visualize the information in a 2dimensional plane with the minimum amount of data loss. The Example 5 data model contains the input data for
this analysis expressed in the Celsius temperature scale.
After restricting the PCA result to exactly 2 eigenvalues, the meteorologist obtained a new set of coordinates,
PCA1 and PCA2:

As the eigenvalues table shows, the 2 new dimensions have retained 91% of the original data, which is impressive
2
taking into account that the original data had twice the amount of dimensions. Furthermore, the SPE and T graphs
indicate that all the resulting data points are reliable, even with an alpha as high as 20%.
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